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About this guide
This guide provides setup and basic troubleshooting information for the HP Z1 G2 Workstation. It 
includes these topics:

Guide topics

Locating HP resources on page 1

HP Z1 G2 Workstation features on page 7

Setting up and using the workstation on page 11

Setting up, backing up, restoring, and recovering Windows 
7 on page 29

Setting up, backing up, restoring, and recovering Windows 
8 on page 34

Setting up and restoring Linux on page 42

Updating the workstation on page 47

Diagnostics and minor troubleshooting on page 49

Routine Care on page 55

TIP: If you do not find what you are looking for in this guide:

● Find technical details in the Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.

● View removal and replacement videos at http://www.hp.com/go/sml.

● Go to http://www.hp.com/go/workstations for additional information on your workstation.
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1 Locating HP resources

This section provides information on the following resources for your HP workstation:

Topics

Product information on page 2

● Technical specifications

● Regulatory, safety and environmental notices

● Accessories

● System board

● Serial number, Certificate of Authenticity, and Genuine 
Microsoft Label

Support on page 3

● Product support

● Warranty information

Product documentation on page 4

● HP and third-party documentation, white papers

● Product notifications

● Technical specifications (QuickSpecs)

● Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 5

● UEFI Diagnostics

● Audible beeps and light code definitions

● POST error codes

Product updates on page 6

● Driver and BIOS updates

● Operating systems

1



Product information
Topic Location

Technical specifications Go to http://www.hp.com/go/quickspecs. In the left pane, select your region and 
then select Workstations.

Regulatory, safety and 
environmental notices

Refer to the Regulatory, Safety and Environmental Notices for product regulatory 
information. You can also refer to the regulatory label on the workstation chassis.

Accessories For complete and current information on supported accessories and components, 
go to http://www.hp.com/go/workstations.

System board A diagram of the system board is located on the inside of the chassis (all-in-one 
configuration). Additional information is located in the workstation Maintenance and 
Service Guide on the Web at http://www.hp.com/support/workstation_manuals/.

Serial number, Certificate of 
Authenticity (COA), and Genuine 
Microsoft® Label (GML) (if 
applicable)

The serial number label is on a pull-out card on the side of the display (all-in-one 
configuration). The COA (Windows 7) and GML (Windows 8) are typically located 
near the serial number label. On some workstations, this label is on the bottom 
panel.

Linux For information on running Linux on HP workstations, go to http://www.hp.com/
linux/, and then select Linux on Workstations from the list on the left.
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Support
Topic Location

Product support For U.S. support, go to http://www.hp.com/go/contactHP.

For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Here you can access the following types of support:

● Chat online with an HP technician

● Obtain email support

● Find support telephone numbers

● Locate an HP service center

Warranty 
information

To locate base warranty information, go to http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, go to http://www.hp.com/go/lookuptool.

To extend a standard product warranty, go tohttp://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand 
a standard product warranty.

You can find the expressly provided HP Limited Warranty applicable to your product located with the 
user guides on your computer and/or on the CD or DVD provided in the box. For some countries or 
regions where the warranty is not provided in printed format, you may request a printed copy from 
http://www.hp.com/go/orderdocuments or write to:

North America:

Hewlett Packard, MS POD

11311 Chinden Blvd.

Boise, ID 83714, USA

Europe, Middle East, Africa:

Hewlett-Packard, POD

Via G. Di Vittorio, 9

20063, Cernusco /Naviglio (MI), Italy

Asia Pacific:

Hewlett-Packard, POD, P.O. Box 200

Alexandra Post Office, Singapore 911507

When you request a printed copy of your warranty, please include your product number, warranty 
period (found on your service label), name, and postal address.

IMPORTANT: Do NOT return your HP product to the addresses above. For U.S. support, go to 
http://www.hp.com/go/contactHP.

For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.
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Product documentation
Topic Location

HP user documentation, white 
papers, and third-party 
documentation

User documentation is located on your hard drive. On Windows 7, select Start, 
select HP Help and Support, and then select HP Documentation. On Windows 8, 
from the Start screen, select the app HP Documentation. For the latest online 
documentation, go to http://www.hp.com/support/workstation_manuals. The 
documentation incudes this user guide and the Maintenance and Service Guide.

Removal and replacement 
videos

To learn how to remove and replace workstation components, go to 
http://www.hp.com/go/sml.

Product notifications Subscriber's Choice is an HP program that allows you to sign up to receive driver 
and software alerts, proactive change notifications (PCNs), the HP newsletter, 
customer advisories, and more. Sign up at http://www.hp.com/go/subscriberschoice.

Technical specifications The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include 
information about the operating system, power supply, memory, CPU, and many 
other system components. To access the QuickSpecs, go to http://www.hp.com/go/
quickspecs/.

Customer Advisories, Security 
Bulletins, and Notices

To find advisories, bulletins, and notices:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Use the scroll bar to select Advisories, Bulletins & Notices under the 
Knowledge Base heading.
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Product diagnostics
Topic Location

Windows 7 dagnostics tools The UEFI Diagnostics utility is preinstalled on select Windows 7 workstations.

For additional information, see the workstation Maintenance and Service Guide at 
http://www.hp.com/support/workstation_manuals.

Windows 8 diagnostics tools The UEFI Diagnostics utility is preinstalled on select Windows 8 workstations.

For additional information, see the workstation Maintenance and Service Guide at 
http://www.hp.com/support/workstation_manuals.

Audible beep and light code 
definitions

See the workstation Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.

POST error codes See the workstation Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.
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Product updates
Topic Location

Driver and BIOS updates Go to http://www.hp.com/go/workstationsupport to verify that you have the latest 
drivers for the workstation.

To determine the current workstation BIOS on your workstation, follow these steps 
during system startup:

1. Turn on the workstation, and press Esc during startup (boot).

2. Press F10 to enter the F10 Setup utility.

3. Go to File > System Information. Note the BIOS version and date and compare 
it with the BIOS versions that appear on the HP website.

In Windows 7, you can also find the BIOS version number by following these steps:

1. Go to Start > All Programs > Accessories > System Tools > System 
Information.

2. In the right pane, find the line with BIOS Version/Date.

3. Note the BIOS version and date and compare it with the versions that appear 
on the HP website.

In Windows 8, you can also find the BIOS version number by following these steps:

1. Point to or swipe from the upper-right or lower-right corner of the Start screen 
to display the charms.

2. Select Settings > Change PC Settings.

Operating systems For information, go to the following locations:

● Operating systems supported on HP workstations, go to http://www.hp.com/go/
wsos.

● Windows operating systems, go to http://www.microsoft.com/support.

● Linux operating systems, go to http://www.hp.com/linux.
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2 HP Z1 G2 Workstation features

The HP Z1 G2 Workstation is offered in both a touch and a non-touch model. The touch model has a 
glossy glass front, and the non-touch model has a matte surface, surrounded by a plastic bezel.

For complete and current information on supported accessories and components for the workstation, 
go to http://partsurfer.hp.com.

Components
Front and bottom components

1 Camera angle adjustment dial 5 Serial number pull-out card

2 Camera 6 Speakers

3 Left and right digital microphones 7 Stand

4 Display panel 8 Chassis latches (bottom view)

Components 7
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Side components

1 Power button 5
USB 3.0 ports (2)

The bottom USB port is also a 
battery charging port.

2 Hard drive activity light 6 Headphone jack

3  Slimline tray optical drive (or 
optional Thunderbolt module) 7 Microphone jack

4  Memory card reader
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Rear components

1  Handle 6  Power cord connector

2 Subwoofer jack (orange) 7 USB 2.0 ports (4)

3 Audio line-out jack (green) 8 Optical S/PDIF audio output

4 Audio line-in jack (blue) 9 RJ-45 network connector

5  DisplayPort connector 10  Security cable slot
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Product specifications
Physical characteristics

Weight

With stand (non-touch)

With stand (touch)

19.2 kg (42.3 lbs)

21.0 kg (46.3 lbs)

Without stand (non-touch)

Without stand (touch)

13.3 kg (29.3 lbs)

15.1 kg (33.3 lbs)

Stand only 5.9 kg (13.0 lbs)

Dimensions

Upright, including stand Height: 533.4 mm (21.0 in)

Width: 660.4 mm (26.0 in)

Depth: 419.1 mm (16.5 in)

Unit only Height: 457.2 mm (18.0 in)

Width: 660.4 mm (26.0 in)

Depth: 81.3 mm (3.2 in)

Environmental specifications

Temperature

Operating: 5°C to 35°C (40°F to 95°F)

Non-operating: -40°C to 60°C (-40°F to 140°F)

NOTE: The ambient upper limit of 35°C is good up to 1524 m (5000 ft) elevation. Derate by 
1°C for every 305 m (1000 ft) above 1524 m (5000 ft). For example, at 3,048 m (10,000 ft), 
the upper ambient air temperature limit is 30°C.

Humidity
Operating: 8% to 85% relative humidity, non-condensing

Non-operating: 8% to 90% relative humidity, non-condensing

Altitude
Operating: 0 to 3,048 m (10,000 ft)

Non-operating: 0 to 9,144 m (30,000 ft)

Shock

Operating: ½-sine: 40g, 2-3ms (~62 cm/sec)

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~105g)

● 20g, square: 422 cm/s

NOTE: Values represent individual shock events and do not indicate repetitive shock 
events.

Vibration

Operating random: 0.5g (rms), 5-300 Hz, up to 0.0025 g2/Hz

Non-operating random: 2.0g (rms), 5-500 Hz, up to 0.0150 g2/Hz

NOTE: Values do not indicate continuous vibration.
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3 Setting up and using the workstation

Topics

Setting up the workstation on page 11

Display options on page 24

Using the webcam on page 28

Installing optional components on page 28

Security on page 28

Product recycling on page 28

Setting up the workstation
Location and ventilation

Proper ventilation for the system is important for workstation operation. To be sure that there is 
adequate ventilation:

● Operate the workstation on a sturdy, level surface.

● Provide at least the following clearance:

◦ 12 cm (4.7 in) clearance at the front, back, top, and bottom of the workstation

◦ 16 cm (6.3 in) clearance on the right side for the optical drive

● Be sure that the ambient air temperature surrounding the workstation falls within the specified 
limits (see Environmental specifications on page 10).

● Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air 
intakes.

Setting up the workstation 11



Setup procedure
1. The HP Z1 G2 Workstation weighs 19.2 kg (42.3 lbs) for the non-touch model and 21.0 kg (46.3 

lbs) for the touch model, and must be removed from the box by two people.

WARNING! If a product is shipped in packaging marked with this icon , the product must 
always be lifted by two people to avoid personal injury due to product weight. 

WARNING! To reduce the risk of electric shock or damage to your equipment:

● Plug the power cord into an AC outlet that is easily accessible at all times.

● Disconnect power from the computer by unplugging the power cord from the AC outlet (not 
by unplugging the power cord from the computer).

● If your power cord has a 3-pin attachment plug, plug the cord into a grounded (earthed) 3-
pin outlet. Do not disable the power cord grounding pin, for example, by attaching a 2-pin 
adapter. The grounding pin is an important safety feature.

For more safety and regulatory information, refer to the Regulatory, Safety and Environmental 
Notices located with the user guide on your computer.

2. Push the unit down to its lowest horizontal position.

CAUTION: Never open the unit unless it is in the lowest horizontal position. Otherwise, system 
components may be damaged.

3. Slide the latches on the bottom of the workstation outward and open the chassis.
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4. Insert the USB wireless transceiver in the internal USB port, and close the chassis.

NOTE: Keep in mind the following:

● An outline around the internal USB port identifies the maximum area allowed for an internal 
USB device. The USB wireless transceiver must fit within this area.

● The USB wireless transceiver is in the keyboard box.

● You can also install the USB wireless transceiver into a side USB port.

● Be sure that the mouse and keyboard are within 30 cm (12 in) of the workstation and away 
from interference from other devices.

5. Press down on the front of the unit, and then press in on the green button until you hear a click.
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6. Raise the unit up to its highest horizontal position.

7. Rotate the monitor to its full vertical upright position (some force is required).

8. Connect the power cord and peripherals.

IMPORTANT: DO NOT insert the USB wireless transceiver at this location. Refer to steps 3 
and 4 for instructions.
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9. Connect the workstation to a grounded AC power outlet (1) and turn on the unit (2).

10. Connect the unit to the Internet through the wireless feature or with an RJ-45 network cable.

To set up a WLAN and connect to the Internet, you need a broadband modem (either DSL or 
cable) (purchased separately), high-speed Internet service purchased from an Internet service 
provider, and a wireless router (purchased separately).

Connecting Bluetooth devices
The workstation is Bluetooth®-enabled. To connect a Bluetooth wireless device:

1. Make your Bluetooth device send out a radio signal so that it is discoverable by the workstation 
(refer to the device documentation for instructions).

2. In the Windows Control Panel, go to Hardware and Sound then to to Devices and Printers.

● If your Bluetooth device is a printer, select Add a printer, select Add a network, wireless or 
Bluetooth printer, and follow the on-screen instructions.

● For all other devices, select Add a device, select Bluetooth devices, and then follow the on-
screen instructions.

Disabling Bluetooth devices
The Bluetooth features can be disabled through the system BIOS, through the operating system, or 
by removing the wireless modules from the system.

NOTE: Disabling the Bluetooth features through the system BIOS or by removing the wireless 
modules from the system will also disable the WLAN functionality.

To disable the Bluetooth features using the system BIOS, do the following:
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1. During system boot, press F10 to enter the BIOS setup.

2. Locate and select the Security menu from the available menu selections displayed near the top 
of the screen.

3. Select Slot Security.

4. Select Slot 1 mini PCIe / mSATA.

5. Use the arrow keys to change Enabled to Disabled, and then press F10 to accept the change.

6. Select File from the header menus, and then select Save Changes and Exit.

To disable the Bluetooth features in Windows 7, do the following:

1. Change View By from Category to either Large Icon or Small Icon.

2. In Control Panel, go to Device Manager.

3. Expand Bluetooth Radios.

4. Find Intel® Wireless Bluetooth® 4.0 Adapter.

5. Select Disable.

6. Select Yes.

7. To re-enable, select Enable.

To disable the Bluetooth features in Windows 8, do the following:

1. Change View By from Category to either Large Icon or Small Icon.

2. In Control Panel, go to Device Manager.

3. Expand Bluetooth.

4. Select Intel® Wireless Bluetooth® 4.0 + HS Adapter to open the menu.

5. Go to the Driver menu and select Disable.

6. Select Yes.

7. To re-enable, select Enable.

To remove the wireless modules, see one of the following for information on removal and 
replacement of components:

● The Maintenance and Service Guide for your workstation at http://www.hp.com/support/
workstation_manuals

● Videos for your workstation at http://www.hp.com/go/sml

Disabling WLAN
NOTE: The HP Z1 G2 Workstation is WLAN-enabled by default.

NOTE: Disabling the WLAN functionality through the system BIOS or by removing the wireless 
modules from the system will also disable the Bluetooth features.

The WLAN can be disabled through the system BIOS, through the operating system, or by removing 
the wireless modules from the system.

To disable the WLAN using the system BIOS, do the following:
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1. During system boot, press F10 to enter the BIOS setup.

2. Locate and select the Security menu from the available menu selections displayed near the top 
of the screen.

3. Select Slot Security.

4. Select Slot 1 mini PCIe / mSATA.

5. Use the arrow keys to change Enabled to Disabled, and then press F10 to accept the change.

6. Select File from the header menus, and then select Save Changes and Exit.

To disable the WLAN in Windows 7, do the following:

1. Change View By from Category to either Large Icon or Small Icon.

2. In Control Panel, go to Device Manager.

3. Expand Network Adapters.

4. Select Intel® Dual Band Wireless-AC 7260.

5. Select Disable.

6. Select Yes.

7. To re-enable, select Enable.

To disable the WLAN in Windows 8, do the following:

1. Change View By from Category to either Large Icon or Small Icon.

2. In Control Panel, go to Device Manager.

3. Expand Network Adapters.

4. Select Intel® Dual Band Wireless-AC 7260.

5. Go to Driver menu.

6. Select Disable.

7. Select Yes.

8. To re-enable, select Enable.

To remove the wireless modules, see one of the following for information on removal and 
replacement of components:

● The Maintenance and Service Guide for your workstation at http://www.hp.com/support/
workstation_manuals

● Videos for your workstation at http://www.hp.com/go/sml

Using touchscreen gestures
A touchscreen computer allows you to control items on the screen directly with your fingers. To use 
touch gestures, you must have a touch model that has Microsoft Windows installed on it.

TIP: On touchscreen computers, you can perform the gestures on the screen or using the keyboard 
and mouse.

NOTE: Not all gestures are supported in all programs. Unless otherwise specified, gestures are 
supported in both Windows 7 and Windows 8.
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One-finger slide
The one-finger slide is mostly used to pan or scroll through lists and pages, but you can use it for 
other interactions, too, such as moving an object.

● To scroll across the screen, lightly slide one finger across the screen in the direction you want to 
move.

NOTE: On Windows 8, when many apps are revealed on the Start screen, you can slide your 
finger to move the screen left or right.

● To drag, press and hold an object, and then drag the object to move it.

Tapping
To make an on-screen selection, use the tap function.

● Use one finger to tap an object on the screen to make a selection. Double-tap an item to open it.

18 Chapter 3   Setting up and using the workstation



Scrolling
Scrolling is useful for moving the pointer up, down, left, or right on a page or image.

● Place two fingers on the screen and then drag them in an up, down, left, or right motion.

Pinching/stretching
Pinching and stretching allows you to zoom out or in on images or text.

● Zoom in by placing two fingers together on the display and then move your fingers apart.

● Zoom out by placing two fingers apart on the display and then move your fingers together.
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Rotating (select models only)
Rotating allows you to turn items such as photos.

● Anchor the forefinger of your left hand on the object you want to rotate. Using your right hand, 
slide your forefinger around in a sweeping motion from 12 o’clock to 3 o’clock. To reverse the 
rotation, move your forefinger from 3 o’clock to 12 o’clock.

NOTE: Rotate is intended for specific apps where you can manipulate an object or image. Rotate 
may not be functional for all apps.

Edge swipes (Windows 8 models only)
With edge swipes you can perform tasks such as changing settings and finding or using apps.

Right-edge swipe
The right-edge swipe reveals the charms, which let you search, share, start apps, access devices, or 
change settings.

● Gently swipe your finger inward from the right edge of the display onto the screen to reveal the 
charms.
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Left-edge swipe
The left-edge swipe reveals your open apps so that you can switch to them quickly.

● Gently swipe your finger inward from the left edge of the display to switch between apps. 
Without lifting your finger, swipe back toward the left edge to reveal all open apps.

Bottom-edge swipe
The bottom-edge swipe allows you to open a list of apps available on your computer.

▲ From the Windows Start screen, gently swipe your finger from the bottom edge of the display 
onto the screen to view available apps.

Tapping
Tap or double-tap an item on the screen as you would click or double-click with an external mouse. 
Tap and hold an item to see the context menu.

NOTE: You must tap and hold your finger until a circle appears around the area you are touching, 
and then the context menu appears.
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Flicking (Windows 7 models only)
Touch the screen in a light, quick flicking motion up, down, left, or right to navigate through screens or 
quickly scroll through documents.

NOTE: For the flick movement to work, a scrollbar must be present in the active window.

Dragging
Press your finger on an item on the screen, and then move your finger to drag the item to a new 
location. You can also use this motion to slowly scroll through documents.

Setting touchscreen preferences
1. To set preferences, perform one of the following:

● (Windows 7) Select Start > Control Panel > Hardware and Sound > Pen and Touch.

● (Windows 8) From the Start screen, select Control Panel, then select Hardware and Sound, 
then select Pen and Touch.

These preferences are specific to the touchscreen and the computer.

2. To set preferences for left-handed or right-handed users, perform one of the following:
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● (Windows 7) Select Start > Control Panel > Hardware and Sound > Tablet PC Settings> 
Other.

● (Windows 8) From the Start screen, select Control Panel, then select Hardware and Sound, 
then select Tablet PC Settings, then select Other.

These preferences are specific to the touchscreen and the computer.
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Display options
Adjusting display brightness

The HP Z1 G2 Workstation uses two methods to control the display brightness.

● The backlight brightness settings control the overall brightness of the internal display panel only.

● The pixel color brightness settings control the individual pixel color intensity for the internal 
display panel and an external monitor. Changing the pixel color brightness will affect the color of 
the pixels and will affect the colors of your display.

Controlling display panel brightness
Internal display panel backlight brightness

Windows 7 and Windows 8 each offer two methods for controlling the backlight brightness of the 
internal display panel. These two options adjust the backlight brightness from 100% down to 30%.

Windows 7

1. Change View By from Category to either Large Icon or Small Icon.

2. Select Control Panel > Power Options.

3. Move the screen brightness slider at the bottom of the window to make adjustments.

4. At the bottom of the window, select Apply or OK to save the changes.

– or –

1. Select Start > Programs > Productivity and Tools > HP My Display.

2. Select Adjust.

3. Move the slider to make adjustments.

4. At the bottom of the window, select Apply or OK to save the changes.

Windows 8

1. Change View By from Category to either Large Icon or Small Icon.

2. Point to the upper-right of the Start screen to display the charms.

3. Select Settings.

4. In the lower-right corner, select Brightness.

5. Move the slider to make adjustments.

Controlling the brightness of the display panel and an external monitor

Pixel color brightness is controlled with either the Intel® iGFx or the NVIDIA MXM graphics controller 
interface. Both controllers can adjust the internal display panel and an external monitor. This 
adjustment affects the brightness level of the individual RGB pixels and affects the colors of the 
pixels.

Intel iGFx adjustments for an internal display panel
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1. Right-click a blank area on the display desktop to open the system display-control window. 
Select Graphics Properties.

2. Select the Advanced option, and select OK. The Intel Graphics and Media control panel opens.

3. From the left side of the Intel Graphics and Media control panel, select Display > Color 
Enhancement.

4. Open the Display drop-down menu, and then select Built-In Display.

5. The brightness slider is set to 0%. Move the slider to adjust the brightness up to 100% or down 
to –60%.

6. At the bottom of the window, select Apply or OK to save the changes.

Intel iGFx pixel color adjustments for an external monitor

1. Right-click a blank area on the display desktop to open the system display-control window. 
Select Graphics Properties.

2. Select the Advanced option, and then select OK. The Intel Graphics and Media control panel 
opens.

3. From the left side of the control panel, select Display > Color Enhancement.

4. Open the Display drop-down menu, and then under External Monitor, select the listing for your 
monitor. For example, if a ZR2740w monitor is connected, select Digital Display ZR2740w.

5. The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6. At the bottom of the window, select Apply or OK to save the changes.

NVIDIA MXM controller pixel color adjustments for an internal display panel

1. Right-click a blank area on the display desktop to open the system display-control window. 
Select the NVIDIA control panel.

2. Select the HP Z1 G2 display panel icon. A green box outlines the icon.

3. On the left side of the NVIDIA Control Panel, select Adjust desktop color settings, and select the 
internal display panel to adjust the settings.

4. Select the Use NVIDIA Settings option.

5. The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6. At the bottom of the window, select Apply or OK to save the changes.

NVIDIA MXM controller pixel color adjustments for an external monitor

1. Right-click a blank area on the display desktop to open the system display-control window. 
Select the NVIDIA control panel.

2. Select the icon for your external monitor. A green box outlines the icon.

3. On the left side of the NVIDIA Control Panel, select Adjust desktop color settings, and select the 
external monitor to adjust the settings.

4. Select the Use NVIDIA Settings option.

5. The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6. At the bottom of the window, select Apply or OK to save the changes.
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Adding an external monitor
To connect a monitor to the workstation:

1. Determine the correct cable and/or adapter requirements for the monitor.

Monitor Interface Required connection

DisplayPort DisplayPort cable

VGA DisplayPort to VGA adapter with VGA cable

DVI DisplayPort to DVI adapter with DVI-D cable

Dual-Link DVI DisplayPort to DLDVI adapter with Dual-Link 
cable

HDMI DisplayPort to HDMI adapter with HDMI cable

2. Connect the DisplayPort end of the cable/adapter to the DisplayPort connector on the back of 
the workstation.

3. Connect the other end of the cable to the external monitor.

4. Turn on the monitor. If the workstation is running Windows and a graphics driver is installed, the 
workstation automatically detects the external monitor and uses it as a display.

Customizing the display panel or an external monitor
You can manually select or change the monitor refresh rates, screen resolution, color settings, font 
sizes, and power management settings of the workstation's display panel or external monitor. Use 
either the control panel of the graphics processing unit (MXM card or integrated graphics) or select 
the Windows Control Panel > Display options.

For more information about customizing your external monitor, refer to the documentation included 
with the monitor.
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Using the HP Z1 G2 Workstation as a monitor
The DisplayPort connector on the HP Z1 G2 Workstation is bi-directional and lets you use the 
workstation as a display for another computer, such as a laptop. The other computer (referred to as 
the external graphics source) must have a graphics DisplayPort output connector.

A set of keystrokes on the workstation keyboard switches the port from output to input and back. 
While in output mode, the port drives an external monitor. While in input mode, an external graphics 
source drives the workstation display panel.

NOTE: This feature is described here as supported on the Windows operating system. Similar 
functionality is available for some Linux operating systems. The Linux package is available for 
download at http://www.hp.com/linux or might be included in the pre-loaded Linux operating system.

To use the workstation as a monitor:

1. Connect one end of a DisplayPort cable to the external graphics source's DisplayPort connector. 
Connect the other end to the DisplayPort connector on the back of the HP Z1 G2 Workstation.

2. On the HP Z1 G2 Workstation keyboard, simultaneously press Ctrl+Shift+S+D (switch display) to 
enable the workstation to display output from the external graphics source.

3. To switch back, simultaneously press Ctrl+Shift+S+D on the HP Z1 G2 Workstation keyboard to 
reinstate the internal graphics source and place the workstation display panel in standby mode. 
On the HP Z1 G2 Workstation, move the mouse or press the space bar to wake up the display 
panel.

NOTE: This feature relies on the My Display utility, which is subject to change with new software 
and driver releases. To download the latest software and driver, go to http://www.portrait.com/
dtune/hpw/enu/upgrade_instructions.html. 
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Adjusting the audio signal
● There is no hardware volume control on the HP Z1 G2 Workstation. (However, some keyboards 

do have volume buttons, usually in the upper-right corner.)

● Volume can be adjusted with the operating system (OS) master control or the software (SW) 
audio player control.

● The OS master control and SW audio player control are independent. However, they are both 
simultaneously active and affect the overall volume of the audio signal.

● If the audio signal is not audible, check the OS master control and SW audio player control to be 
sure that neither is set too low.

Using the webcam
The webcam works automatically with any webcam software.

A white activity light is on when the webcam is active. Optimal performance of the fixed-focus lens is 
at 0.5 meters.

A dial at the top of the workstation lets you perform the following tasks:

● Adjust the camera angle.

● Disable the camera by turning the dial all the way toward the front of the workstation. A red 
stripe in the camera viewport indicates the lens is pointing straight down into the chassis. The 
user is not visible.

Installing optional components
You can install additional components such as memory, hard drives, and wireless modules in your 
workstation.

● To view component installation videos, go to http://www.hp.com/go/sml.

● For installation guidelines and technical information, refer to the Maintenance and Service Guide 
at http://www.hp.com/support/workstation_manuals.

Security
You can secure your workstation by attaching a lock to the security cable slot. The workstation 
includes several security features to reduce the risk of theft and to warn of chassis intrusion. Refer to 
the Maintenance and Service Guide for information about additional hardware and software security 
features available for your system.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and 
rechargeable batteries.

For information about recycling HP components or products, go to http://www.hp.com/go/recycle.
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4 Setting up, backing up, restoring, and 
recovering Windows 7

This chapter provides setup and update information for the Windows 7 operating system. It includes 
these topics:

● Setting up the Windows 7 operating system

● Backing up, restoring, and recovering Windows 7

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the 
operating system is successfully installed. Adding hardware might cause errors and prevent the 
operating system from installing correctly.

NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software 
updates are installed on the workstation. See Updating the workstation on page 47.

Setting up the Windows 7 operating system
CAUTION: After installation has started, do not turn off the workstation until the process is 
complete. Turning off the workstation during installation can damage the installation and operation of 
the software.

For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the Windows 7 online Help after you successfully 
install the operating system.

Installing or upgrading device drivers
You must install the appropriate device drivers before you install hardware devices. Follow the 
installation instructions that came with each device. For optimum performance, your operating system 
must have the most recent updates, patches, and service packs. See http://www.hp.com for HP-
qualified drivers. For additional driver and software update information, see Updating the workstation 
on page 47.
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Transferring files and settings
The Windows operating system offers data migration tools that help you select and transfer files and 
data from one Windows-based workstation to another.

For information about these tools, go to http://www.microsoft.com.

Backing up, restoring, and recovering Windows 7
Your workstation includes tools provided by HP and Windows to help you safeguard your information 
and retrieve it if you ever need to. These tools will help you return your workstation to a proper 
working state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating backups

● Restoring and recovering your system

NOTE: For more details about the Windows Backup and Restore tools provided, see Help and 
Support. To access Help and Support: select Start, and then select Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the workstation, use Windows tools to create recovery media. In 
Windows 7, select Start > Control Panel > System and Security > Backup and Restore > Create 
a system image.

2. As you add hardware and software programs, create system restore points. A system restore 
point is a snapshot of certain hard drive contents saved by Windows System Restore at a 
specific time. A system restore point contains information that Windows uses, such as registry 
settings. Windows creates a system restore point for you automatically during a Windows update 
and during other system maintenance activities (such as a software update, security scanning, 
or system diagnostics). You can also manually create a system restore point at any time. For 
more information and steps for creating specific system restore points, see Help and Support. To 
access Help and Support: select Start, and then select Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal 
information. If files are accidentally deleted from the hard drive and they can no longer be 
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you 
backed up. In case of system failure, you can use the backup files to restore the contents of your 
workstation. See Backing up your information on page 30.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case 
of system instability.

Backing up your information
NOTE: Windows includes the User Account Control feature to improve the security of your 
workstation. You may be prompted by User Account Control for your permission or password when 
you perform certain tasks. To continue a task, select the appropriate option. For information about 
User Account Control, see Help and Support: select Start and then select Help and Support.

You should create your initial backup immediately after initial system setup. As you add new software 
and data files, you should continue to back up your system on a regular basis to maintain a 
reasonably current backup. Your initial and subsequent backups allow you to restore your data and 
settings if a failure occurs.
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NOTE: For detailed instructions on various backup and restore options, perform a search for these 
topics in Help and Support. To access Help and Support: select Start and then select Help and 
Support.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up your information:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot 
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the 
workstation.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your workstation, use 
System Restore to return the workstation to a previous restore point. You can also set restore points 
manually.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:

1. Close all open programs.

2. Select Start, select Computer, and then select Properties.

3. Select System protection > System Restore > Next, and then follow the on-screen instructions.
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System Recovery
CAUTION: This procedure will delete all user information. To prevent loss of information, be sure to 
back up all user information so you can restore it after recovery.

Always use the System Restore procedure before you use the System Recovery program. See 
System Restore on page 31.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you 
have created, and then reinstalls the operating system, programs, and drivers. However, you must 
reinstall any software that was not installed on the workstation at the factory. This includes software 
that came on media included in the workstation accessory box, and any software programs that you 
have installed.

You can order a recovery media set from support. For U.S. support, go to http://www.hp.com/support. 
For worldwide support, go to http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also 
order the recovery media set by calling support.

NOTE: Some features might not be available on systems that are shipped without a Windows 
operating system.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. 
The recovery image is a file that contains a copy of the original factory-shipped software. To 
perform a System Recovery from a recovery image, see System Recovery from a recovery 
partition image on page 32.

● Recovery media — Run System Recovery from recovery media that you have purchased 
separately.

System Recovery from a recovery partition image

CAUTION: System Recovery deletes all data and programs that you have created or installed.

A Windows system from the HP factory ships with a recovery partition. You can use the recovery 
partition to recover the factory operating system.

1. Turn off the workstation. If necessary, press and hold the power button until the workstation 
turns off.

2. Disconnect all peripheral devices from the workstation except the monitor, keyboard, and 
mouse.

3. Press the power button to turn on the workstation.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the 
Windows is Loading Files... message appears on the screen.

5. At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the workstation, reconnect all peripheral devices, and 
then turn the workstation back on.
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Using HP Recovery Disc operating system discs

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and 
reformats the hard drive. All files that you have created and any software that you have installed on 
the workstation are permanently removed. When reformatting is complete, the recovery process 
helps you restore the operating system, as well as the original drivers. Software that came with the 
system can be downloaded at http://www.hp.com.

Use the steps provided in this section if you ordered a Windows 7 operating system DVD and Driver 
DVD.

To order a Windows 7 operating system DVD and Driver DVD, go to the HP website. For U.S. 
support, go to http://www.hp.com/cgi-bin/hpsupport/index.pl. For worldwide support, go to 
http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also order the DVDs by calling 
support.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This recovery process takes several minutes.

1. Backup all personal files.

2. Restart the workstation, and then insert the Windows 7 operating system DVD into the optical 
drive.

NOTE: If the workstation does not boot to the DVD, restart the workstation and press Esc as 
the workstation is powering on to see the startup menu. Use the arrow keys to select the boot 
menu and press enter. Use the arrow keys to select the location where the recovery DVD is 
inserted to boot from that device. Booting the DVD from UEFI Boot sources will result in a GPT 
boot partition. Booting from Legacy Boot sources will result in an MBR boot partition.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the operating system installation has completed:

1. Eject the Windows 7 operating system DVD, and insert the Driver DVD once the system is 
booted into the OS for the first time.

NOTE: The Driver DVD will load prerequisite software, and then allow you to load drivers.

2. Install the Hardware Enabling Drivers. HP recommends installing all available drivers.

3. You can download applications that came with the workstation at http://www.hp.com.

NOTE: For more information on using the restore media, refer to the white paper “Restoring 
Windows 7 on the HP Z420, Z620 and Z820: Using HP OS DVD and Driver DVD.” This white paper 
can be found on http://www.hp.com/support.
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5 Setting up, backing up, restoring, and 
recovering Windows 8

This chapter provides setup and update information for the Windows 8 operating system. It includes 
these topics:

Topics

Setting up the Windows 8 operating system on page 34

Backing up, restoring, and recovering Windows 8 
on page 35

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the 
operating system is successfully installed. Adding hardware might cause errors and prevent the 
operating system from installing correctly.

NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software 
updates are installed on the workstation. Refer to the chapter on updating the workstation.

Supplementary information
Additional information is available in Help and Support after you customize the operating system. To 
learn more about Windows 8, review the Windows Basics guide included with your computer. The 
guide provides information on common tasks using the touchscreen or the keyboard.

Setting up the Windows 8 operating system
The first time you turn on the computer you can customize the operating system. When you are 
connected to the Internet, Microsoft activates your operating system. This process takes about 15 to 
30 minutes. Carefully read and follow the instructions on the screen.

We recommend that you register your computer with HP, so you can receive important software 
updates, request support, and sign up for special offers.

CAUTION: After the initial setup process has begun, DO NOT TURN OFF THE COMPUTER UNTIL 
THE PROCESS IS COMPLETE. Turning off the computer during this process may damage the 
software that runs the computer or prevent its proper installation.

NOTE: Windows includes the User Account Control feature to improve the security of your 
computer. You may be prompted by User Account Control for your permission or password when you 
perform certain tasks. To continue a task, select the appropriate option. For information about User 
Account Control, see Help and Support: from the Start screen type help and then select Help and 
Support.

34 Chapter 5   Setting up, backing up, restoring, and recovering Windows 8



Downloading Windows 8 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally, 
HP recommends checking for the latest updates during the initial installation and periodically 
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Select Settings > Change PC Settings > Update and Recovery > Windows Update.

Backing up, restoring, and recovering Windows 8
Your computer includes tools provided by HP and Windows to help you safeguard your information 
and retrieve it if you ever need to. These tools will help you return your computer to a proper working 
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: For more details about the tools provided, see Help and Support. From the Start screen, 
type help, and then select Help and Support.

HP recommends that you print the recovery procedures and save them for later use, in case of 
system instability.

Backing up your information
NOTE: Windows includes the User Account Control feature to improve the security of your 
computer. You may be prompted by User Account Control for your permission or password when you 
perform certain tasks. To continue a task, select the appropriate option. For information about User 
Account Control, from the Start screen type help and then select Help and Support.

Recovery after a system failure is as good as your most recent backup. You should create system 
repair media and your initial backup immediately after initial system setup. As you add new software 
and data files, you should continue to back up your system on a regular basis to maintain a 
reasonably current backup. The system repair media is used to start up (boot) the computer and 
repair the operating system in case of system instability or failure. Your initial and subsequent 
backups allow you to restore your data and settings if a failure occurs.

NOTE: For detailed instructions on various backup and restore options, perform a search for these 
topics in Help and Support. To access Help and Support: from the Start screen, type help and then 
select Help and Support.

From the Start screen, type backup, and then select Save backup copies of your files with File 
History.

You can back up your information to an optional external hard drive or a network drive.

Note the following when you perform a backup:
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● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot 
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Windows Backup and Restore:

NOTE: The backup process may take more than an hour, depending on file size and the speed of 
the computer.

1. From the Start screen, type backup, and then select from the list of displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create 
system repair media.
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Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.

CAUTION: Use a flash drive with a capacity of at least 8 GB. Any information on the USB flash drive 
will be erased before the recovery media is created.

1. After you successfully set up the computer, create recovery media. This step creates a backup 
of the recovery partition on the computer. The backup can be used to reinstall the original 
operating system in cases where the hard drive is corrupted or has been replaced.

You will use a USB flash drive to create a bootable recovery drive that can be used to 
troubleshoot a Windows 8 computer that is unable to start. The USB flash drive can be used to 
reinstall the original operating system and the programs that were installed at the factory.

CAUTION: If you select Copy contents from the recovery partition to the recovery drive, you 
will have the option to delete the recovery partition when the Recovery Media creation is 
finished. On most systems, this partition is 10 GB in size. HP recommends that you not delete 
this recovery partition. If the partition is deleted, you will be unable to restore the Windows 8 
factory recovery partition to the hard drive using the recovery USB drive. You can free up drive 
space by deleting the recovery partition, but you won't be able to refresh or reset the PC again.

To create the recovery media, from the Start screen, type create a recovery drive, and 
then select Create a recovery drive. Follow the on-screen instructions to continue.

2. As you add hardware and software programs, create system restore points. A system restore 
point is a snapshot of certain hard drive contents saved by Windows System Restore at a 
specific time. A system restore point contains information that Windows uses, such as registry 
settings. Windows automatically creates a system restore point for you during a Windows update 
and during other system maintenance activities (such as a software update, security scanning, 
or system diagnostics). You can also manually create a system restore point at any time. For 
more information and steps for creating specific system restore points, see Windows Help and 
Support. From the Start screen, type help, and then select Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal 
information. Windows File History can be set to regularly and automatically back up files from 
libraries, desktop, contacts, and favorites. If files are accidentally deleted from the hard drive and 
they can no longer be restored from the Recycle Bin, or if files become corrupted, you can use 
File History to restore the files that you backed up. Restoring files is also useful if you ever 
choose to reset the computer by reinstalling Windows.

NOTE: File History is not enabled by default, so you must turn it on.

For more information and steps for enabling Windows File History, see Windows Help and 
Support. From the Start screen, type help, and then select Help and Support.

Restoring and recovering using Windows 8 tools
Windows recovery tools provide access to several options for recovering your system. Choose the 
method that best matches your situation and level of expertise:

● If you need to restore your personal files and data, you can use Windows File History to restore 
your information from the backups you created. For more information and steps for using File 
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History, see Windows Help and Support. From the Start screen, type help, and then select Help 
and Support.

● If you want to restore the system to a previous state without losing any personal information, 
Windows System Restore is an option. System Restore allows you to restore without the 
requirements of Windows Refresh or a reinstallation. Windows creates system restore points 
automatically during a Windows update and other system maintenance events. Even if you did 
not manually create a restore point, you can choose to restore to an automatically created 
restore point. For more information and steps for using Windows System Restore, see Windows 
Help and Support. From the Start screen, type help, and then select Help and Support.

● If you want a quick and easy way to recover the system without losing your personal information, 
settings, or the apps that came preinstalled on your computer or were purchased from the 
Windows Store, Windows Refresh is an option. This method does not require backing up data to 
another drive. See Using Windows 8 Refresh on page 38.

● If you want to reset your computer to its original state, Windows Reset provides an easy way to 
remove all personal data, apps, and settings, and reinstall Windows. The Reset recovery tool 
reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled. Any personal files must be restored 
from backups you made. See Using Windows 8 Reset on page 39.

● If the computer is unable to start, you can use the Windows recovery USB flash drive you 
created to recover the system. See Recovery using the Windows 8 recovery USB flash drive 
on page 40.

● If the computer is unable to start and you did not create a recovery USB flash drive or the one 
you created does not work, see Recovery using Windows 8 restore media on page 41.

Using Windows 8 Refresh

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the 
system at the factory.

NOTE: You may be prompted by User Account Control for your permission or password when you 
perform certain tasks. To continue a task, select the appropriate option. For information about User 
Account Control, see Help and Support: from the Start screen type help, and then select Help and 
Support.

If Windows is responding, use these steps to start Refresh:

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a 
quick way to see what you might need to reinstall. See Help and Support for instructions on 
reinstalling traditional applications. From the Start screen, type help, and then select Help and 
Support.

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the 
charms.

2. Select Settings.

3. Select Change PC settings in the bottom-right corner of the screen, and then select Update and 
Recovery > Recovery from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the on-screen 
instructions.

If Windows is not responding, use these steps to start Refresh:
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1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: from the Start screen, type 
This PC, and then select This PC.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you 
must recover using the recovery media that you created. See Recovery using the Windows 8 
recovery USB flash drive on page 40. If you did not create recovery media, you must use the 
Windows 8 restore media (available separately). See Recovery using Windows 8 restore media 
on page 41.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the 
company logo is displayed. The computer Startup Menu opens.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Refresh.

8. Follow the on-screen instructions to continue.

Using Windows 8 Reset

IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up 
any personal information you want to retain.

If Windows is responding, use these steps to start Reset:

NOTE: You may be prompted by User Account Control for your permission or password when you 
perform certain tasks. To continue a task, select the appropriate option. For information about User 
Account Control, see Help and Support: from the Start screen type help, and then select Help and 
Support.

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the 
charms.

2. Select Settings.

3. Select Change PC settings in the bottom-right corner of the screen, select Update and Recovery 
then select Recovery

4. Under Remove everything and reinstall Windows, select Get started, and follow the on-screen 
instructions.

If Windows is not responding, use these steps to start Reset:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: from the Start screen, type 
This PC, and then select This PC.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you 
must recover using the recovery media that you created. See Recovery using the Windows 8 
recovery USB flash drive on page 40. If you did not create recovery media, you must use the 
Windows 8 restore media (available separately). See Recovery using Windows 8 restore media 
on page 41.
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3. If the HP Recovery partition is listed, restart the computer, and then press esc while the 
company logo is displayed. The computer Startup Menu opens.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows 8 recovery USB flash drive

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files 
that you have created and any software that you have installed on the computer are permanently 
removed. The f11 recovery tool reinstalls the operating system and the HP programs and drivers that 
were installed at the factory. You must reinstall all other software.

To recover your system using the recovery USB flash drive you previously created:

NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see 
Recovery using Windows 8 restore media on page 41.

1. If possible, back up all personal files.

2. Insert the recovery USB flash drive into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of 
boot devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. 
Press enter.

4. Choose your keyboard layout.

5. Select Troubleshoot.

6. Select Refresh your PC.

7. Follow the on-screen instructions.
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Recovery using Windows 8 restore media
This recovery process requires Windows 8 restore discs, which can be ordered from the support 
website. The Windows 8 restore media consists of a Windows 8 operating system disc and a 
Windows 8 driver disc.

For U.S. support, go to http://www.hp.com/support. For worldwide support, go to 
http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also order the media by calling 
support.

CAUTION: Using the Windows 8 operating system disc completely erases hard drive contents and 
reformats the hard drive. All files that you have created and any software that you have installed on 
the computer are permanently removed. When reformatting is complete, the recovery process helps 
you restore the operating system, as well as drivers, software, and utilities.

Begin recovery using the Windows 8 operating system disc:

NOTE: It can take several minutes to load the operating system disc.

1. Back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8 operating 
system disc to install the operating system.

3. When prompted, press any keyboard key.

NOTE: If the computer does not boot to the DVD, restart the computer and press esc as the 
computer is starting to see the Startup menu. Use the arrow keys to select the boot menu, and 
then press enter. Use the arrow keys to select the location where the recovery DVD is inserted 
to boot from that device. Booting the DVD from UEFI Boot sources will result in a GPT boot 
partition. Booting from Legacy Boot sources will result in an MBR boot partition. It is 
recommended that you boot Windows 8 from UEFI Boot sources to take full advantage of the 
features available in Windows 8.

4. Follow the on-screen instructions.

After the repair is completed and the Windows 8 desktop appears:

1. Remove the Windows 8 operating system disc, and then insert the driver disc.

NOTE: The driver disc will load prerequisite software, and then allow you to load drivers and 
applications.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

3. Install Recommended Applications of your choice. Only applications that are not available for 
download from http://www.hp.com are included on the driver disc.
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6 Setting up and restoring Linux

HP offers a variety of Linux solutions for HP workstation customers:

● HP certifies and supports Red Hat® Enterprise Linux (RHEL) on HP workstations.

● HP certifies and supports SUSE Linux Enterprise Desktop (SLED) on HP workstations.

● HP offers a SLED 11 preload on some Z series Workstations.

This chapter describes how to set up and restore the Linux operating system. It includes these topics:

Topics

HP Installer Kit for Linux (HPIKL) on page 43

Setting up Red Hat Enterprise Linux on page 43

Setting up SUSE Linux Enterprise Desktop (SLED) on page 45

Proprietary graphics drivers on page 46

NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software 
updates are installed. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the workstation until the operating 
system is successfully installed. Adding hardware might cause errors and prevent the operating 
system from installing correctly.

HP Linux Support Matrix
Not all release streams are supported on particular platforms. To find out which streams are 
supported on your workstation. see the Linux certification and support matrix:

1. Go to http://www.hp.com/linux.

2. On the Platforms tab, click HP Workstations.

3. Under the heading Certification Matrix, select your Linux version.

4. Select the appropriate tab.
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HP Installer Kit for Linux (HPIKL)
The HP Installer Kit for Linux helps users install certified versions of RHEL or SLED on HP 
workstations. It is available as an operating system option on all HP workstations.

● The kit contains tested drivers that augment and/or replace those found in RHEL or SLED, to 
enable proper use and behavior on HP workstations.

● The kit does not include the Linux operating system, which must be purchased separately from 
Red Hat or SUSE. To view supported configurations and operating systems, go to 
http://www.hp.com/support/linux_hardware_matrix.

The HPIKL option includes a FreeDOS preload. This operating system option accommodates those 
who have a customized Linux distribution or who have a licensed version of RHEL or SLED and 
would like to install the HP-recommended driver additions.

The kit also can be downloaded using the following steps:

1. Go to http://www.hp.com/support/workstation_swdrivers.

2. Select your workstation model.

3. Select the desired operating system.

4. Select your software/driver language, and then click the Software quick jump link.

5. Select the Obtain Software link for the appropriate package (typically the most recent revision).

6. Click I Accept to accept the terms of the license agreement.

7. Download the software ISO image and save it on a disc. This disk is your HP driver disc.

Setting up Red Hat Enterprise Linux
HP Z series Workstations are certified and supported on RHEL streams appropriate to the hardware 
technology.

● For details of RHEL support for a particular platform, see the Hardware Support Matrix for HP 
Linux Workstations at http://www.hp.com/support/linux_hardware_matrix.

● For information about Red Hat certifications on HP workstations, go to 
https://hardware.redhat.com.
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HPIKL driver disc
Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP 
workstations. These releases can usually be supported with the HPIKL driver disc, which can be used 
as a post-installation utility for the standard Red Hat Linux install.

After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility 
runs. After you specify a number of settings (such as the security level, time and date, root password, 
user accounts), the utility lets you load an additional disc.

The driver disc is used during this phase. All content added by HP is in the /HP directory on the disc. 
You can use it to build your own image or to browse the HP content.

NOTE: Some installations may encounter problems if they are performed with a DisplayPort 
connection to the monitor. This is because the default drivers that the OS installers use do not 
support DisplayPort functionality. If you experience problems, try overriding the monitor choice for 
DisplayPort during the start of the install and using the VESA driver instead. You can then set up the 
DisplayPort monitor later.

Installing with the HP Red Hat Linux driver disc
1. If you do not have the appropriate HP driver disc for a supported stream, create one (see HP 

Installer Kit for Linux (HPIKL) on page 43.)

2. Install the operating system using the optical media included in the Red Hat Linux box-set.

3. If you have a Red Hat driver disk for the OS version you are installing, enter linux dd when 
the initial install splash screen appears, and then press Enter.

4. When asked if you have a driver disc, select Yes. Place the Red Hat driver disc in the drive, and 
select the appropriate drive:hd[abcd]. Continue the normal installation.

5. After successfully installing the operating system, reboot the workstation.

● RHEL 5: the Red Hat Setup Agent (also known as first-boot) automatically starts. At the 
Additional DVDs screen, insert your HP driver disc and select Install. When the driver 
installation task is completed, continue following the prompts until the operating system is 
successfully installed.

● RHEL 6: Insert your HP driver disc. The HPIKL installation software automatically starts. 
Follow the on-screen instructions to install the contents.

44 Chapter 6   Setting up and restoring Linux



Setting up SUSE Linux Enterprise Desktop (SLED)
HP offers a 64-bit SLED 11 preload on some Z series Workstations and supports 64-bit SLED 11 on 
other workstations.

Various versions of SLED are certified and supported by SUSE on HP workstations. For more 
information, go to the SUSE certification bulletin search page at https://www.suse.com/yessearch/
Search.jsp.

Setting up preloaded SLED
To set up SLED on systems preloaded with the operating system:

1. Start the workstation.

2. When prompted, enter the workstation installation settings: password, network, graphics, time, 
keyboard settings, and SUSE Customer Center Configuration.

NOTE: You can activate your SUSE subscription from the SUSE Customer Center 
Configuration screen. To view the full SUSE Customer Center documentation, go to 
http://www.suse.com/documentation, and select your operating system.

Installing SLED with the DVD Installer Kit
1. If an HP driver disc did not come with your workstation, create one (see HP Installer Kit for Linux 

(HPIKL) on page 43).

2. Install the operating system using the discs included in the SUSE box-set.

3. After successfully installing the operating system, reboot the workstation.

4. Insert your HP driver disc. The HPIKL installation software automatically starts. Follow the on-
screen instructions to install the contents.
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Restoring SLED (preloaded systems only)
To restore SLED, you must use the SLED restore media. To create restore media:

1. Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all ISO 
images used to preload your workstation.

2. Follow the instructions in the readme file in this folder to copy the ISO image file onto optical 
media.

3. Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO 
recovery images tor restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the 
method and media of your choice.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive 
verification by HP. See the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/
support/linux_hardware_matrix for a list of supported cards.

NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for 
cards that consume large amounts of power in lower-power workstations.

Proprietary graphics drivers supported by HP and the graphics vendors are available with the HP 
Installer Kit for Linux, with the SLED 11 preload on Z series Workstations, and from HP Workstation 
Support at http://www.hp.com/go/workstationsupport.

These proprietary drivers are not a standard part of the RHEL or SLED distributions because they are 
not open source. Driver revisions more recent than those at the HP support website are supported 
directly by the vendor.
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7 Updating the workstation

HP is constantly working on improving your total workstation experience. To be sure that your 
workstation leverages the latest enhancements, HP recommends that you install the latest BIOS, 
driver, and software updates on a regular basis.

Updating the workstation after first start
After successfully starting the workstation for the first time, you should follow these guidelines to be 
sure that the workstation is up to date:

● Be sure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 47.

● Be sure that you have the latest drivers for your system. See Upgrading device drivers 
on page 48.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if 
necessary.

Determining the current BIOS version
To determine the current BIOS version:

1. Press Esc during startup.

2. Press F10 to enter the F10 Setup utility.

3. Select File > System Information. Note the workstation BIOS version and compare it with the 
BIOS versions that appear on the HP website.

NOTE: Procedures for upgrading the BIOS, as well as the F10 Computer Setup utility BIOS 
Menu settings, are located in the Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.
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Upgrading BIOS
To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the website is the same as the version on your system, no further action is 
required.

5. If the BIOS on the website is a version later than the one on your system, download the 
appropriate version for the workstation. Follow the instructions in the release notes to complete 
the installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm that 
you have the latest device drivers loaded. If you purchased your device through HP, visit the HP 
website to download the latest drivers for your device. These drivers have been tested to be sure the 
best compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP website first to see if 
your device and its drivers have been tested for HP workstation compatibility. If no driver is available, 
go to the device manufacturer's website to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select the menu option Download Options, and then select Drivers, Software & Firmware.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, go to the website of the manufacturer of the peripheral device.
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8 Diagnostics and minor troubleshooting

Calling support
At times you might encounter an issue that requires support. Before you call support:

● Have the computer readily accessible.

● Write down the computer serial numbers, product numbers, model names, and model numbers 
and have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking lights on the front of the computer (tower and desktop 
configurations) or on the side of the computer (all-in-one configurations).

● Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example: 
PS988AV) of the computer. If the computer has a product number, it is generally located next to the 
10- or 12-digit serial number of the computer.

NOTE: The serial number and product number labels can be found on a pull-out card at the side of 
the display.

For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your 
region, and then, in the upper-right corner, select Connect with HP.
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Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each 
computer.

● All workstations have a serial number (unique for each workstation) and product number. Have 
these numbers available when you contact support.

● The Certificate of Authentication (COA) is used only for systems with Windows 7 preinstalled.

● The Genuine Microsoft Label (GML) is used only for systems with Windows 8 preinstalled.

● A service label shows the build ID and Feature Byte strings, which are needed for system board 
replacement.

The all-in-one service label can be found in the location shown in the figure below (pull-out card).
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Locating warranty information
To locate base warranty information, go to http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, go to http://www.hp.com/go/lookuptool.

To extend a standard product warranty, go to http://www.hp.com/hps/carepack. HP Care Pack 
Services offer upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, online support, and helpful 
hints for troubleshooting.

Online support
Online access and support resources include web-based troubleshooting tools, technical knowledge 
databases, driver and patch downloads, online communities, and product change notification 
services.

The following websites are also available to you:

● http://www.hp.com—Provides useful product information.

● http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

● http://www.hp.com/go/workstationsupport—Provides technical support information for 
workstations.

● http://www.hp.com/support—Provides a listing of the worldwide technical support phone 
numbers. Access the telephone numbers by visiting the website, select your region, and then, in 
the upper-right corner, select Contact HP.

● http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for 
workstations.
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Troubleshooting a problem
To help you troubleshoot problems with your system, HP provides the HP Support Center. The HP 
Support Center is a portal to an extensive selection of online tools. To access the HP Support Center 
and troubleshoot a problem with the workstation, complete the following steps:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Select a product, select your product.

4. On the Troubleshoot a problem page, select the problem that you are troubleshooting.

Instant Support and Active Chat
HP Instant Support is a set of web-based support tools that automate and speed up the resolution of 
problems concerning desktop computing, tape storage, and printing.

Active Chat enables you to electronically submit a support ticket to HP over the web. When you 
submit a support ticket, Active Chat collects information about the computer and passes it to an 
online support specialist. The collection of information might take up to 30 seconds, depending on the 
computer configuration. When you submit a support ticket, you receive a confirmation message 
containing your case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, go to 
http://instantsupport.hp.com/.

NOTE: This feature is not available for Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:

1. Go to www.hp.com/go/workstationsupport.

2. Select a product.

3. Under the Knowledge Base heading, select Advisories, Bulletins & Notices.

4. Review the list of advisories, bulletins and notices, and select an item for viewing.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within 
a 30-60 day window of the effective date of the change in the manufacturing process. PCNs give 
customers advanced notice of changes to their product, such as an updated BIOS version that they 
may need to qualify prior to the change taking place. To view a list of PCNs, see the section called 
"Customer Advisories, Customer and Security Bulletins, and Customer Notices."

52 Chapter 8   Diagnostics and minor troubleshooting

http://www.hp.com/go/workstationsupport
http://instantsupport.hp.com/


Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following general 
suggestions might help you isolate and focus on the problem before taking further action.

At startup
● Verify that the workstation is plugged into a functional AC power outlet.

● Remove all optical discs and USB flash drives before starting the workstation.

● Verify that the workstation is turned on and the power light is on.

● If you have installed an operating system other than the factory-installed operating system, 
confirm that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the internal display panel is lit.

● If the internal display panel is dim, turn up the brightness.

● If you have an external monitor:

◦ Verify that the monitor is plugged into a functional AC power outlet.

◦ Verify that the monitor is turned on and the green monitor light is on.

◦ If the monitor is dim, turn up the brightness and contrast controls.

During operation
● Look for blinking lights on the workstation. The blinking lights are error codes that will help you 

diagnose the problem. Refer to the Diagnostic LED and audible (beep) codes section in the 
Maintenance and Service Guide for your workstation for information on interpreting diagnostic 
lights and audible codes.

● Press and hold any key. If the system beeps, and then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing the power button or any key on the keyboard. If the system 
remains in suspend mode, shut down the system by pressing and holding the power button for 
at least four seconds, and then press the power button again to restart the system. If the system 
does not shut down, unplug the power cord, wait a few seconds, and then plug it in again. If it 
does not restart, press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option. 
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected 
a printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network 
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware to see whether the workstation 
functions properly.

● If you recently installed new software, uninstall the software to see whether the workstation 
functions properly.

● If the internal display panel on an all-in-one computer is blank, open the computer and be sure 
that both ends of the cable between the system board and the internal display panel are 
connected. If you are using a graphics card, verify that the card is properly installed.
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● Upgrade the BIOS. A new release of the BIOS might have been released that supports new 
features or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Maintenance and Service 
Guide at http://www.hp.com/support/workstation_manuals.

Customer Self Repair
Under the Customer Self Repair programs, you can order a replacement part and install the part 
without onsite HP technical assistance. Customer Self Repair might be required for some 
components. Go to http://www.hp.com/go/selfrepair for information on the program.

NOTE: Some components are not eligible for Customer Self Repair and must be returned to HP for 
service. Call support for further instructions before attempting to remove or repair these components.

Other troubleshooting options
The following additional troubleshooting techniques and tools are located in the Maintenance and 
Service Guide at http://www.hp.com/support/workstation_manuals:

● POST Error Codes

● Diagnostic lights and audible beep codes

● Troubleshooting scenarios and solutions

● UEFI Diagnostics
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9 Routine Care

The cleaning methods listed below are applicable to both the touch and the non-touch models of the 
HP Z1 G2 Workstation.

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the computer.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

● Always unplug the computer before cleaning the keyboard, mouse, or air vents.

● Always disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when using compressed air, to prevent dust and 
debris from getting into your eyes.

Cleaning products
Use the following products to safely clean your computer:

● Dimethyl benzyl ammonium chloride 0.3 percent maximum concentration, usually in the form of 
disposable wipes in a variety of brand names

● Alcohol-free glass cleaning fluid

● Water with mild soap solution

● Dry microfiber cleaning cloth or a chamois (static-free cloth without oil)

● Static-free cloth wipes

CAUTION: Avoid strong cleaning solvents that can permanently damage your computer. If you 
are not sure if a cleaning product is safe for your computer, check the product contents to be 
sure that ingredients such as alcohol, acetone, ammonium chloride, methylene chloride, and 
hydrocarbons are not included. 

● Fibrous materials, such as paper towels, can scratch the computer. Over time, dirt particles and 
cleaning agents can get trapped in the scratches.
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Cleaning the chassis
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before 

cleaning the computer.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a soft microfiber cloth or chamois moistened with mild dish washing 
liquid diluted with water. Rinse well by wiping the surface with a cloth or swab dampened with 
clear water.

● After cleaning, always wipe the computer with a clean, lint-free cloth.

● Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the 
vents and limit the airflow.

Cleaning the keyboard
● If the keyboard has an on/off switch, turn it off.

● Follow the safety precautions in the Maintenance and Service Guide for your workstation before 
cleaning the keyboard.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because 
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key remover to prevent damage to the keys. This 
tool is available from many electronic supply outlets.

CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys 
are improperly removed or installed, the keyboard might not function properly.

● Clean under a key with a swab moistened with one of the products mentioned in Cleaning 
products on page 55 of this guide. Be careful not to wipe away lubricants necessary for proper 
key functions. Allow the parts to air dry before reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before 

cleaning the monitor.

● Gently wipe the display using a soft, lint-free cloth moistened with water or an alcohol-free glass 
cleaner.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the 
housing and damage a component. 

Never use solvents or flammable liquids on the monitor because display or housing damage 
may result.
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Cleaning the mouse
1. Follow the safety precautions in the Maintenance and Service Guide for your workstation before 

cleaning the mouse.

2. If the mouse has an on/off switch, turn it off.

3. Wipe the body of the mouse with a soft microfiber cloth or chamois moistened with alcohol-free 
glass cleaning fluid or water with mild soap solution.

4. Note these guidelines:

● Laser or light: use a cotton swab dampened with cleaning solution to gently brush out any 
dust around the laser or light, and then wipe again with a dry swab. Do not wipe the laser or 
light directly with the swab.

● Scroll wheel: spray canned, pressurized air into the gap between the scroll wheel and the 
click buttons. To avoid condensation, do not blow air directly on one spot for an extended 
period.

● Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe 
out the socket with a dry cloth, and reassemble the mouse.
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